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SD UHS-I—An Overview
The Keysight Technologies SD compliance test tool supports compliance tests for SD cards Default 
Speed, High Speed, SDR 12/25/50/104, and DDR 50.
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SD UHS-I Card Compliance Test Application — At A Glance
The Keysight U7246A/U7246B SD UHS-I Card Compliance Test Application is a test solution that 
covers bus output timing analysis, threshold level tests and current consumption tests of the SD 
(Secure Digital) specifications, specifically version 3.0. The software helps you test SD device under 
test compliance with the Keysight 9000 or 90000A Series Infiniium Digital Storage Oscilloscope.

There are two main categories of test modes:

• SD Card Tests - These tests are based on the SD compliance specification and are compared to 
corresponding compliance test limits.

• Work Place Holder - Allows control of the SD Compliance test board.

The SD UHS-I Card Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for each test, with the new multi trial run capability.

• Provides detailed information of each test that has been run. The result of maximum twenty five 
worst trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run.

The minimum number of probes required for the tests are:

• Bus Output Timing Tests - 2x InfiniiMax probes

• Current Consumption Tests - 1x InfiniiMax probe and 1x current probe
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Required Equipment and Software

In order to run the SD UHS-I automated tests, you need the following equipment and software:

• 9000 or 90000A Series Infiniium Digital Storage Oscilloscope. Keysight recommends using 2.5 
GHz or higher bandwidth oscilloscope. 

• The minimum version of the Infiniium Oscilloscope Software (see the U7246A/U7246B SD Card 
UHS-I Compliance Test Application release notes).

• U7246A/U7246B SD UHS-I Card Compliance Test Application.

• Two 1169A, 1168A, 1134A, 1132A, or 1131A InfiniiMax probe amplifiers

• Two E2678A differential socketed probe head

• One N278xA current probe with N2779A power supply and E2697A high impedance adapter

• One SD Compliance test board:

SD compliance test board TD-BD-SDCMPT

Note: Available from Tokyo Electron Device - Japan only

or

SD UHS-I compliance test fixture kit BIT-SD-TFK-0001

Note: Available from BitifEye Digital Test Solutions

http://www.bitifeye.com/cms/front_content.php?idart=205

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

Below are the required licenses:

• U7246A/U7246B SD UHS-I Card Compliance Test Application license.

• E2688A Serial Data Analysis and Clock Recovery software license.

http://www.bitifeye.com/cms/front_content.php?idart=205
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In This Book
This manual describes the tests that are performed by the SD UHS-I Card Compliance Test 
Application in more detail.

NOTE
Refer to the “SD Specifications Part 1 Physical Layer Specification Version 
3.01”, which can be found at https://www.sdcard.org/ for the values 
assigned to various parameters in the tests described in Chapter 3, “SD 
UHS-I Compliance Test Procedures”. 

https://www.sdcard.org/
https://www.sdcard.org/
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Contact Keysight
For more information on SD UHS-I Card Compliance Test Application or other Keysight 
Technologies’ products, applications and services, please contact your local Keysight office. The 
complete list is available at:

www.keysight.com/find/contactus

Phone or Fax

United States:

(tel) 800 829 4444

(fax) 800 829 4433

Canada:

(tel) 877 894 4414

(fax) 800 746 4866

China:

(tel) 800 810 0189

(fax) 800 820 2816

Europe:

(tel) 31 20 547 2111

Japan:

(tel) (81) 426 56 7832

(fax) (81) 426 56 7840

Korea:

(tel) (080) 769 0800

(fax) (080) 769 0900

Latin America:

(tel) (305) 269 7500

Taiwan:

(tel) 0800 047 866

(fax) 0800 286 331

Other Asia Pacific Countries:

(tel) (65) 6375 8100

(fax) (65) 6755 0042

E-mail: tm_ap@keysight.com

http://www.keysight.com/find/contactus
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Installing the Software

1 Make sure you have the minimum version of Infiniium Oscilloscope Software (see the 
U7246A/U7246B SD Card UHS-I Compliance Test Application release notes).

2 To obtain the SD UHS-I Compliance Test Application, go to Keysight website: 
http://www.keysight.com/find/scope-apps-sw/.

3 The link for SD UHS-I Compliance Test Application will appear. Double-click the link and follow 
the instructions to download and install the application software.

http://www.keysight.com/find/scope-apps-sw
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Installing the SD UHS-1 Compliance Test Application 1

Installing the License Key

1 Request a license code from Keysight by following the instructions on the Entitlement Certificate.

You will need the oscilloscope’s “Option ID Number”, which you can find in the Help>About 
Infiniium... dialog box.

2 After you receive your license code from Keysight, choose Util ities>Install Option License....

3 In the Install Option License dialog, enter your license code and click Install License.

4 Click OK in the dialog that tells you to restart the Infiniium oscilloscope application software to 
complete the license installation.

5 Click Close to close the Install Option License dialog.

6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application software to complete the license installation.
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Calibrating the Oscilloscope  /  16
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Before running the SD UHS-I automated tests, you should calibrate the oscilloscope and probe. After 
the oscilloscope and probe have been calibrated, you are ready to start the SD UHS-I Compliance 
Test Application and perform the measurements.
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Calibrating the Oscilloscope

If you haven’t already calibrated the oscilloscope and probe, see Chapter 4, “Calibrating the Infiniium 
Oscilloscope and Probe”.

NOTE
If the ambient temperature changes more than 5 degrees Celsius from the calibration temperature, 
internal calibration should be performed again. The delta between the calibration temperature and 
the present operating temperature is shown in the Utilities>Calibration menu.

NOTE
If you switch cables between channels or other oscilloscopes, it is necessary to perform cable and 
probe calibration again. Keysight recommends that, once calibration is performed, you label the 
cables with the channel on which they were calibrated.
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Preparing to Take Measurements 2

Starting the SD UHS-I Compliance Test Application

1 The SD Compliance Test board is required for SD card testing. The test board provides the SD 
card with a power supply, clock, and command/data transition. The test tool software must be 
installed on the Keysight Infiniium oscilloscope. Connect USB A-B cable to the Keysight Infiniium 
oscilloscope to be used in the automated test. 

2 To start the SD UHS-I Compliance Test Application, from the Infiniium Oscilloscope’s main menu, 
choose Analyze>Automated Test Apps>U7246A/U7246B SD Card UHS-I Test App.

Figure 1 Starting the SD UHS-I Compliance Test Application
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Figure 2 The SD UHS-I Compliance Test Application’s Default Window

Figure 2 shows the SD UHS-I Compliance Test Application main window. The task flow pane, and the 
tabs in the main pane, show the steps you take in running the automated tests:

Tab Description

Set Up Lets you identify and set up the test environment.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select all tests in 
a group. After tests are run, status indicators show which tests have passed, failed, or not been run, and 
there are indicators for the test groups.

Configure Lets you configure test parameters (i.e., channels used in the test, voltage levels).

Connect Shows you how to connect the oscilloscope to the device-under-test for the tests to be run.
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Preparing to Take Measurements 2

Run Tests Starts the automated tests. If the connections to the device-under-test need to be changed while multiple 
tests are running, the tests pause, show you how to change the connection, and wait for you to confirm that 
the connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the thresholds at 
which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

Tab Description
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SD UHS-I Compliance Test Item Coverage

The Keysight SD UHS-I Compliance Test Application covers the SD specification Part 1 of the 
Physical Test Specification for Card Version 3.00.

6-1-1 Threshold Levels

• Output High Voltage, VOH — Defaul t

• Output Low Voltage, VOL — Defaul t

• Output High Voltage, VOH — High Speed

• Output Low Voltage, VOL — High Speed

6-1-4 Current Consumption

• Current Consumption Write — Defaul t

• Current Consumption Read — Defaul t

• Current Consumption Write — High Speed

• Current Consumption Read — High Speed

6-1-6 Bus Timing

Reduced Connection Mode: Bus Output Timing DAT0/DAT1/DAT2/DAT3 and CMD

• tODLAY MAX — Defaul t

• tODLAY MIN — Defaul t

• tODLAY — High Speed

• tOH — High Speed

6-2-1 Threshold Levels

• Output High Voltage, VOH — SDR 12

• Output Low Voltage, VOL — SDR 12

• Output High Voltage, VOH — SDR 25

• Output Low Voltage, VOL — SDR 25

• Output High Voltage, VOH — SDR 50

• Output Low Voltage, VOL — SDR 50

• Output High Voltage, VOH — SDR 104

• Output Low Voltage, VOL — SDR 104

• Output High Voltage, VOH — DDR 50

• Output Low Voltage, VOL — DDR 50

6-2-5 Current Consumption

• Current Consumption Write — SDR 12

• Current Consumption Read — SDR 12

• Current Consumption Write — SDR 25

• Current Consumption Read — SDR 25

• Current Consumption Write — SDR 50

• Current Consumption Read — SDR 50

• Current Consumption Write — SDR 104

• Current Consumption Read — SDR 104

• Current Consumption Write — DDR 50
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SD UHS-I Compliance Test Procedures 3

• Current Consumption Read — DDR 50

6-2-8 Output Drivers

Precision Measurement Mode: Bus Output Timing for DAT0/DAT1/DAT2/DAT3 and CMD

• Rise Time — SDR50

• Fall Time — SDR50

• Rise/Fall Time Mismatch — SDR50

• Rise Time — SDR104

• Fall Time — SDR104

• Rise/Fall Time Mismatch — SDR104

6-2-11 CMD/DAT Output Fixed Timing For SDR

• tODLAY — SDR12

• tOH — SDR12

• tODLAY — SDR25

• tOH — SDR25

• tODLAY — SDR50

• tOH — SDR50

6-2-12 CMD/DAT Output Variable Timing for SDR

• tOP — SDR104

• tODW — SDR104

6-2-14 CMD/DAT Input and Output Timing for DDR

• tODLAY2X MAX — DDR50

• tODLAY2X MIN — DDR50
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Threshold Levels Tests

• Output High Voltage, VOH — Defaul t

• Output Low Voltage, VOL — Defaul t

• Output High Voltage, VOH — High Speed

• Output Low Voltage, VOL — High Speed

• Output High Voltage, VOH — SDR12

• Output Low Voltage, VOL — SDR12

• Output High Voltage, VOH — SDR25

• Output Low Voltage, VOL — SDR25

• Output High Voltage, VOH — SDR50

• Output Low Voltage, VOL — SDR50

• Output High Voltage, VOH — SDR104

• Output Low Voltage, VOL — SDR104

• Output High Voltage, VOH — DDR50

• Output Low Voltage, VOL — DDR50

Test Procedure

Output High Voltage, VOH

1 Set VDD to 2.7 V and according to the test you select, set the appropriate speed mode 
(Defaul t/High Speed/SDR12/SDR25/SDR50/SDR104/DDR50).

2 Trigger on “Random” test pattern during the READ operation.

3 For DAT0/DAT1/DAT2/DAT3 data line, acquire 10,000 unit intervals (UI) on the waveform to perform 
measurements.
For CMD Lane, acquire 1000 UI on the waveform to perform measurements.

4 Generate the Eye patterns from the acquired waveforms.

5 Use the Histogram feature on the Infiniium Oscilloscope to measure the Output High Voltage. 
Record the minimum value as VOH.

6 Report VOH as the resultant value in the final test results.

Figure 3 Output High Voltage, VOH
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SD UHS-I Compliance Test Procedures 3

Output Low Voltage, VOL

1 Set VDD to 3.6 V and according to the test you select, set the appropriate speed mode 
(Defaul t/High Speed/SDR12/SDR25/SDR50/SDR104/DDR50).

2 Trigger on “Random” test pattern during the READ operation.

3 For DAT0/DAT1/DAT2/DAT3 data line, acquire 10,000 unit intervals (UI) on the waveform to perform 
measurements.
For CMD Lane, acquire 1000 UI on the waveform to perform measurements.

4 Generate the Eye patterns from the acquired waveforms.

5 Use the Histogram feature on the Infiniium Oscilloscope to measure the Output Low Voltage. 
Record the maximum value as VOL.

6 Report VOL as the resultant value in the final test results.

Figure 4 Output Low Voltage, VOL
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Current Consumption Tests

• Current Consumption Write — Defaul t

• Current Consumption Read — Defaul t

• Current Consumption Write — High Speed

• Current Consumption Read — High Speed

• Current Consumption Write — SDR12

• Current Consumption Read — SDR12

• Current Consumption Write — SDR25

• Current Consumption Read — SDR25

• Current Consumption Write — SDR50

• Current Consumption Read — SDR50

• Current Consumption Write — SDR104

• Current Consumption Read — SDR104

• Current Consumption Write — DDR50

• Current Consumption Read — DDR50

Test Procedure

1 Set VDD to 3.6 V and according to the test you select, set the appropriate speed mode 
(Defaul t/High Speed/SDR12/SDR25/SDR50/SDR104/DDR50).

2 Trigger on “Toggle” test pattern during either WRITE or READ operation depending on the test 
you have selected.

3 Measure Vdd pin Current Vavg value for the entire 1s waveform. 

4 Report Vavg/N (mA) and check against the specification value for Pass/Fail (where N is the 
number of loop coils used with the current probe).

Figure 5 Current Consumption Read and Current Consumption Write



SD UHS-I Compliance Testing Methods of Implementation 27

SD UHS-I Compliance Test Procedures 3

Output Drivers Tests

Precision Measurement Mode: Bus Output Timing for DAT0/DAT1/DAT2/DAT3 and CMD

• Rise Time — SDR50

• Fall Time — SDR50

• Rise/Fall Time Mismatch — SDR50

• Rise Time — SDR104

• Fall Time — SDR104

• Rise/Fall Time Mismatch — SDR104

Test Procedure

1 Set VDD to 2.7 V and according to the test you select, set the appropriate speed mode 
(SDR50/SDR104).

2 Trigger on “Random” test pattern during the READ operation.

3 For DAT0/DAT1/DAT2/DAT3 data line, acquire 1000 unit intervals (UI) on the waveform to perform 
measurements.
For CMD Lane, acquire 100 UI on the waveform to perform measurements.

4 Measure the Output Rise Time between VOL max (0.45 V) and VOH min (1.4 V) through the entire 
acquired waveform.

5 Measure the Output Fall Time between VOH min (1.4 V) and VOL max (0.45 V) through the entire 
acquired waveform. 

6 Report Rise Time, Fall Time and the ratio of Rise/Fall Time value for Pass/Fail.



3 SD UHS-I Compliance Test Procedures

28 SD UHS-I Compliance Testing Methods of Implementation

Bus Timing Tests (Default)

Reduced Connection Mode: Bus Output Timing DAT0/DAT1/DAT2/DAT3 and CMD

• tODLAY MAX — Defaul t

• tODLAY MIN — Defaul t

Test Procedure

Output Delay Time, tODLAY MAX

1 Set VDD to 2.7 V and the speed mode to Defaul t.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VIL(max) = 0.25 x VDD = 0.675 V
VIH(min) = 0.625 x VDD = 1.6875 V
VOL(max) = 0.125 x VDD = 0.3375 V
VOH(min) = 0.75 x VDD = 2.025 V

Figure 6 Card output timing (Speed mode - Default)

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVIL MAX. Place 
the Histogram window at VIL (max) and VIH (min) on the CLK falling edge waveform. Record the 
maximum value as tVIL MAX (CLK Falling Edge).
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SD UHS-I Compliance Test Procedures 3

Figure 7 tVIL MAX (CLK Falling Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (right edge of the Histogram). Record the maximum value as tVO Max 
(Eye Diagram Edges). 

Figure 8 tVO Max (Eye Diagram Edges)

8 Measure delta time of tVIL MAX (CLK Falling edge) to tVO MAX (Eye Diagram Edges). Record the 
resultant value as tODLAY MAX.
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Figure 9 tODLAY MAX

9 Report the resultant value of tODLAY MAX as the final test result.

Output Delay Time, tODLAY MIN

1 Set VDD to 2.7 V and the speed mode to Defaul t.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VIL(max) = 0.25 x VDD = 0.675 V
VIH(min) = 0.625 x VDD = 1.6875 V
VOL(max) = 0.125 x VDD = 0.3375 V
VOH(min) = 0.75 x VDD = 2.025 V

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVIH MIN. Place 
the Histogram window at VIL (max) and VIH (min) on the CLK falling edge waveform. Record the 
minimum value as tVIH MIN (CLK Falling Edge).



SD UHS-I Compliance Testing Methods of Implementation 31

SD UHS-I Compliance Test Procedures 3

Figure 10 tVIH MIN (CLK Falling Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (left edge of the Histogram). Record the minimum value as tVO MIN 
(Eye Diagram Edges).

Figure 11 tVO MIN (Eye Diagram Edges)

8 Measure delta time of tVIH MIN (CLK Falling edge) to tVO MIN (Eye Diagram Edges). Record the 
resultant value as tODLAY MIN.
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Figure 12 tODLAY MIN

9 Report the resultant value of tODLAY MIN as the final test result.



SD UHS-I Compliance Testing Methods of Implementation 33

SD UHS-I Compliance Test Procedures 3

Bus Timing Tests (High-Speed)

Reduced Connection Mode: Bus Output Timing DAT0/DAT1/DAT2/DAT3 and CMD

• tODLAY — High Speed

• tOH — High Speed

Test Procedure

Output Delay Time, tODLAY

1 Set VDD to 2.7 V and the speed mode to High Speed.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
50% VDD = 0.5 x VDD = 1.35 V
VOL(max) = 0.125 x VDD = 0.3375 V
VOH(min) = 0.75 x VDD = 2.025 V

Figure 13 Card Output timing (High Speed mode)

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVDD50%. Place 
the Histogram window at 50% VDD on the CLK rising edge waveform. Record the mode value as 
tVDD50% (CLK Rising Edge).
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Figure 14 tVDD50% (CLK Rising Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (right edge of the Histogram). Record the maximum value as tVO (Eye 
Diagram Edges).

Figure 15 tVO (Eye Diagram Edges)

8 Measure delta time between tVDD50% (CLK Rising edge) to tVO (Eye Diagram Edges). Record the 
resultant value as tODLAY.
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Figure 16 tODLAY

9 Report the resultant value of tODLAY as the final test result.

Output Hold Time, tOH

1 Set VDD to 2.7 V and the speed mode to High Speed.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
50% VDD = 0.5 x VDD = 1.35 V
VOL(max) = 0.125 x VDD = 0.3375 V
VOH(min) = 0.75 x VDD = 2.025 V

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVDD50%. Place 
the Histogram window at 50% VDD on the CLK rising edge waveform. Record the mode value as 
tVDD50% (CLK Rising Edge).
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Figure 17 tVDD50% (CLK Rising Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (left edge of the Histogram). Record the minimum value as tVO (Eye 
Diagram Edges).

Figure 18 tVO (Eye Diagram Edges)

8 Measure delta time between tVDD50% (CLK Rising edge) to tVO (Eye Diagram Edges). Record the 
resultant value as tOH.
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Figure 19 tOH

9 Report the resultant value of tOH as the final test result.
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CMD/DAT Output Fixed Timing for SDR Tests

Reduced Connection Mode: Bus Output Timing DAT0/DAT1/DAT2/DAT3 and CMD.

• tODLAY — SDR12

• tOH — SDR12

• tODLAY — SDR25

• tOH — SDR25

• tODLAY — SDR50

• tOH — SDR50

Test Procedure

Output Delay Time, tODLAY

1 Set VDD to 2.7 V and according to the test you select, set the appropriate speed mode 
(SDR12/SDR25/SDR50).

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(max) = 0.45 V
VOH(min) = 1.40 V

Figure 20 Output Timing of the Fixed Data Window

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVCT. Place the 
Histogram window at VCT on the CLK rising edge waveform. Record the mode value as tVCT (CLK 
Rising Edge).
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Figure 21 tVCT (CLK Rising Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (right edge of the Histogram). Record the maximum value as tVO (Eye 
Diagram Edges).

Figure 22 tVO (Eye Diagram Edges)

8 Measure delta time between tVCT (CLK Rising edge) and tVO (Eye Diagram Edges). Record the 
resultant value as tODLAY.
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Figure 23 tODLAY

9 Report the resultant value of tODLAY as the final test result.

Output Hold Time, tOH

1 Set VDD to 2.7 V and according to the test you select, set the appropriate speed mode 
(SDR12/SDR25/SDR50).

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(max) = 0.45 V
VOH(min) = 1.40 V

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVCT. Place the 
Histogram window at VCT on the CLK rising edge waveform. Record the mode value as tVCT (CLK 
Rising Edge).
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Figure 24 tVCT (CLK Rising Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (left edge of the Histogram). Record the minimum value as tVO (Eye 
Diagram Edges).

Figure 25 tVO (Eye Diagram Edges)

8 Measure delta time between tVCT (CLK Rising edge) and tVO (Eye Diagram Edges). Record the 
resultant value as tOH.
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Figure 26 tOH

9 Report the resultant value of tOH as the final test result.
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CMD/DAT Output Variable Timing for SDR Tests

• tOP — SDR104

• tODW — SDR104

Test Procedure

Output Valid Window Drift, tOP

1 Set VDD to 2.7 V and select the speed mode to SDR104.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(min) = 0.45 V
VOH(max) = 1.40 V

Figure 27 Output Timing of the Variable Data Window

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVCT. Place the 
Histogram window at VCT on the CLK rising edge waveform. Record the mode value as tVCT (CLK 
Rising Edge).
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Figure 28 tVCT (CLK Rising Edge)

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (right edge of the Histogram). Record the maximum value as tVO (Eye 
Diagram Edges).

Figure 29 tVO (Eye Diagram Edges)

8 Measure delta time between tVCT (CLK Rising edge) and tVO (Eye Diagram Edges). Record the 
resultant value as tOP.



SD UHS-I Compliance Testing Methods of Implementation 45

SD UHS-I Compliance Test Procedures 3

Figure 30 tOP

9 Report the resultant value of tOP as the final test result.

Output Valid Data Window, tODW

1 Set VDD to 2.7 V and select the speed mode to SDR104.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(min) = 0.45 V
VOH(max) = 1.40 V

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the value for tVO (Eye Diagram 
Left Edges) and tVO (Eye Diagram Right Edges).

7 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (right edge of the Histogram). Record the maximum value as tVO (Eye 
Diagram Left Edges).
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Figure 31 tVO (Eye Diagram Left Edges)

8 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position (left edge of the Histogram). Record the minimum value as tVO (Eye 
Diagram Right Edges).

Figure 32 tVO (Eye Diagram Right Edges)

9 Measure delta time between tVO (Eye Diagram Left Edges) and tVO (Eye Diagram Right Edges). 
Record the resultant value as tODW.
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Figure 33 tODW

10 Report the resultant value of tODW as the final test result.
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CMD/DAT Input and Output Timing for DDR Tests

• tODLAY2X_MAX — DDR50

• tODLAY2X_MIN — DDR50

Test Procedure

Output Delay Time, tODLAY2X_MAX

1 Set VDD to 2.7 V and select the speed mode to DDR50.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(max) = 0.45 V
VOH(min) = 1.40 V

Figure 34 Timing Diagram DAT Inputs/Outputs referenced to CLK in DDR50 speed mode

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the values for tVCT (CLK Rising 
Edge) and tVCT (CLK Falling Edge).

7 Place the Histogram window at VCT on CLK rising edge waveform and record the mode value as 
tVCT (CLK Rising Edge).
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Figure 35 tVCT (CLK Rising Edge)

8 Place the Histogram window at VCT on CLK falling edge waveform and record the mode value as 
tVCT (CLK Falling Edge).

9 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position. Record the maximum value as tVO at CLK Rise Edge (Eye Diagram 
Edges).

Figure 36 tVO at CLK Rise Edge (Eye Diagram Edges)

10 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position. Record the maximum value as tVO at CLK Fall Edge (Eye Diagram 
Edges).
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Figure 37 tVO at CLK Fall Edge (Eye Diagram Edges)

11 Measure delta time between tVCT (CLK Rising Edge) and tVO at CLK Rise Edge (Eye Diagram 
Edges). Record the resultant value as CLK Rise Edge to tODLAY2X_MAX.

Figure 38 CLK Rise Edge to tODLAY2X_MAX

12 Measure delta time between tVCT (CLK Falling Edge) and tVO at CLK Fall Edge (Eye Diagram 
Edges). Record the resultant value as CLK Fall Edge to tODLAY2X_MAX.
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Figure 39 CLK Fall Edge to tODLAY2X_MAX

13 Measure the worst value for CLK Rise Edge to tODLAY2X_MAX and CLK Fall Edge to tODLAY2X MAX. 
Record the resultant value.

14 Report the resultant value as the final test result.

Output Hold Time, tODLAY2X_MIN

1 Set VDD to 2.7 V and select the speed mode to DDR50.

2 Trigger on “Random” test pattern during the READ operation.

3 Acquire 10,000 unit intervals (UI) on the waveform to perform measurements. 

4 Generate Eye patterns from the acquired waveform.

5 Each reference amplitude is as follows:
VCT = 0.975 V
VOL(max) = 0.45 V
VOH(min) = 1.40 V

6 Use the Histogram feature on the Infiniium Oscilloscope to measure the values for tVCT (CLK Rising 
Edge) and tVCT (CLK Falling Edge).

7 Place the Histogram window at VCT on CLK rising edge waveform and record the mode value as 
tVCT (CLK Rising Edge).
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Figure 40 tVCT (CLK Rising Edge)

8 Place the Histogram window at VCT on CLK falling edge waveform and record the mode value as 
tVCT (CLK Falling Edge).

9 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position. Record the minimum value as tVO at CLK Rise Edge (Eye Diagram 
Edges).

Figure 41 tVO at CLK Rise Edge (Eye Diagram Edges)

10 Place the Histogram window at VOL(max) and VOH(min) on Data/CMD waveform to determine the 
worst Eye opening position. Record the minimum value as tVO at CLK Fall Edge (Eye Diagram 
Edges).



SD UHS-I Compliance Testing Methods of Implementation 53

SD UHS-I Compliance Test Procedures 3

Figure 42 tVO at CLK Fall Edge (Eye Diagram Edges)

11 Measure delta time between tVCT (CLK Rising Edge) and tVO at CLK Rise Edge (Eye Diagram 
Edges). Record the resultant value as CLK Rise Edge to tODLAY2X_MIN.

Figure 43 CLK Rise Edge to tODLAY2X_MIN

12 Measure delta time between tVCT (CLK Falling Edge) and tVO at CLK Fall Edge (Eye Diagram 
Edges). Record the resultant value as CLK Fall Edge to tODLAY2X_MIN.
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Figure 44 CLK Fall Edge to tODLAY2X_MIN

13 Measure the worst value for CLK Rise Edge to tODLAY2X_MIN and CLK Fall Edge to tODLAY2X MIN. 
Record the resultant value.

14 Report the resultant value as the final test result.
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This section describes the Keysight Infiniium Digital Storage Oscilloscope calibration procedures.
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Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium Oscilloscope in preparation for running the SD UHS-I automated tests, you 
need the following equipment:

• Keyboard, qty = 1, (provided with the Keysight Infiniium Oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium Oscilloscope).

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, qty = 2 (provided with 
the Keysight Infiniium Oscilloscope).

• Calibration cable (provided with the 90000A Series Infiniium Oscilloscopes). Use a good quality 
50 Ω BNC cable. 

Figure 45 Accessories Provided with the Keysight Infiniium Oscilloscope

Precision 3.5 mm Adapters (2)

BNC 
Shorting Cap
(Used to cal ibrate 
54850A series 
oscilloscopes)

Calibration Cable
(Used to cal ibrate 54850A, 
90000A Series Oscilloscopes)
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Internal Calibration

This process performs an internal diagnostic and calibration cycle for the Oscilloscope. For the 
Keysight Oscilloscope, this is referred to as Calibration. This Calibration takes about 20 minutes. 
Perform the following steps:

1 Set up the Oscilloscope with the following steps:

a Connect the keyboard, mouse and power cord to the rear of the Oscilloscope.

b Plug in the power cord.

c Turn on the Oscilloscope by pressing the power button located on the lower left of the front 
panel.

d Allow the Oscilloscope to warm up at least 30 minutes prior to starting the calibration 
procedure in step 3 below.

2 Locate and prepare the accessories required for the internal calibration:

a Locate the BNC shorting cap.

b Locate the calibration cable.

c Locate the two Keysight precision SMA/BNC adapters.

d Attach one SMA adapter to the other end of the calibration cable - hand tighten snugly.

e Attach another SMA adapter to the other end of the calibration cable - hand tighten snugly.

3 Referring to Figure 46 below, click Util ities>Calibration menu to open the Calibration dialog box.

Figure 46 Accessing the Calibration menu
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4 Referring to Figure 47 below, perform the following steps to start the calibration:

a Uncheck the Cal Memory Protect checkbox.

b Click the Start button to begin the calibration.

Figure 47 Oscilloscope Calibration Process

c During the calibration of Channel 1, if you are prompted to perform a Time Scale Calibration, 
as shown in Figure 48 below.
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Figure 48 Calibration Options to perform Time Scale Calibration

d Select the Standard Cal and Defaul t Time Scale radio button to continue the calibration using the 
factory default calibration factors.

e When the calibration procedure is complete, you will be prompted with a Calibration Complete 
message. Click the OK button to close this window.

f Confirm that the Vertical and Trigger Calibration Status for all Channels passed.

g Click the Close button to close the calibration window. The internal calibration is completed.

NOTE
These steps do not need to be performed every time a test is run. However, if the ambient 
temperature changes more than 5 degrees Celsius from the calibration temperature, this 
calibration should be performed again. The delta between the calibration temperature and the 
present operating temperature is shown in the Util ities>Calibration menu.
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Required Equipment for Probe Calibration 

Before performing SD UHS-I tests, you must calibrate the probes. Calibration of the solder-in probe 
heads consist of a vertical calibration and a skew calibration. The vertical calibration should be 
performed before the skew calibration. Both calibrations should be performed for best probe 
measurement performance.

The calibration procedure requires the following parts.

• BNC (male) to SMA (male) adapter

• Deskew fixture

• 50 Ω SMA terminator
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Probe Calibration

Connecting the Probe for Calibration

For the following procedure, refer to Figure 49 below.

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the connector closest to the 
yellow pincher.

2 Connect the 50 Ω SMA terminator to the connector farthest from yellow pincher.

3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium Oscilloscope.

4 Connect the probe to an Oscilloscope Channel.

5 To minimize the wear and tear on the probe head, it should be placed on a support to relieve the 
strain on the probe head cables.

6 Push down the back side of the yellow pincher. Insert the probe head resistor lead underneath 
the center of the yellow pincher and over the center conductor of the deskew fixture. The 
negative probe head resistor lead or ground lead must be underneath the yellow pincher and 
over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the 
probe head is approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.
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Figure 49 Solder-in Probe Head Calibration Connection Example

BNC to SMA 
Connector

Pincher

Deskew Fixture

50 W SMA 
Terminator
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Verifying the Connection

1 On the Infiniium Oscilloscope, press the autoscale button on the front panel.

2 Set the volts per division to 100 mV/div.

3 Set the horizontal scale to 1.00 ns/div.

4 Set the horizontal position to approximately 3 ns. You should see a waveform similar to that in 
Figure 50 below.

Figure 50 Example of a Good Connection Waveform

5 If you see a waveform similar to that of Figure 51 below, then you have a bad connection and 
should check all of your probe connections.
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Figure 51 Example of a Bad Connection Waveform
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Running the Probe Calibration and Deskew

1 On the Infiniium Oscilloscope in the Setup menu, select the Channel connected to the probe, as 
shown in Figure 52.

Figure 52 Selection of Channel Setup Dialog from the Setup menu

2 In the Channel dialog box, select the Probe... button, as shown in Figure 53.
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Figure 53 Channel Dialog Box

3 In the Probe Configuration dialog, click the Uncalibrated button (either for Atten/Offset or for Skew) in 
the Calibration Status area, as shown in Figure 54.

Figure 54 Probe Setup dialog

4 In the Probe Cal ibration dialog box, click the Start Atten/Offset Cal... button in the DC 
Attenuation/Offset Cal area and follow the on-screen instructions for the vertical calibration 
procedure. Refer to Figure 55.

5 Once the vertical calibration has successfully completed, click the Start Skew Cal... button in the 
Skew Calibration area and follow the on-screen instructions for skew calibration. Refer to 
Figure 55.
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Figure 55 Probe Calibration dialog

At the end of each calibration, the Oscilloscope prompts you if the calibration was or was not 
successful.
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Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this verification. However, 
if you want to verify that the probe was properly calibrated, the following procedure will help you 
verify the calibration.

The calibration procedure requires the following parts:

• BNC (male) to SMA (male) adapter

• SMA (male) to BNC (female) adapter

• BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838

• Keysight 54855-61620 calibration cable (Infiniium Oscilloscopes with bandwidths of 6 GHz and 
greater only)

• Keysight 54855-67604 precision 3.5 mm adapters (Infiniium Oscilloscopes with bandwidths of 6 
GHz and greater only)

• Deskew fixture

For the following procedure, refer to Figure 56.

1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the connector closest to the 
yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the yellow pincher.

3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the deskew fixture to one 
of the unused Oscilloscope Channels. For Infiniium Oscilloscopes with bandwidths of 6 GHz and 
greater, use the 54855-61620 calibration cable and the two 54855-64604 precision 3.5 mm 
adapters.

4 Connect the BNC side of the deskew fixture to the Aux Out (or Cal Out) BNC of the Infiniium 
Oscilloscope.

5 Connect the probe to an Oscilloscope Channel.

6 To minimize the wear and tear on the probe head, it should be placed on a support to relieve the 
strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head resistor lead underneath 
the center of the yellow pincher and over the center conductor of the deskew fixture. The 
negative probe head resistor lead or ground lead must be underneath the yellow pincher and 
over one of the outside copper conductors (ground) of the deskew fixture. Make sure that the 
probe head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.

9 On the Oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the Channel connected to the BNC cable from the pull-down 
menu.

11 Select the Probe Cal... button.

12 Select the Calibrated Skew radio button.

13 Click the Start Skew Cal... button and follow the on-screen instructions.

14 Once the skew calibration is completed, close all dialog boxes.
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Figure 56 Example of Probe Calibration Verification Connection

BNC to SMA 
Connector
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Deskew 
Fixture

50 W SMA 
Terminator
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15 Set the vertical scale for the displayed channels to 100 mV/div.

16 Set the horizontal range to 1.00 ns/div.

17 Set the horizontal position to approximately 3 ns.

18 Change the vertical position knobs of both channels until the waveforms overlap each other.

19 Click the Setup menu and choose Acquisition....

20 In the Acquisition dialog box, select Enabled for Averaging. When you close the dialog box, you 
should see waveforms similar to that in Figure 57.

Figure 57 Example of a Calibration Probe Waveform

NOTE
Each probe is calibrated with the Oscilloscope Channel to which it is connected. Do not switch 
probes between Channels or other Oscilloscopes, or it will be necessary to calibrate them again. It 
is recommended that the probes be labeled with the Channel on which they were calibrated.
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